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Chapter 1: Linearization QuickStart Guide

This Linearization QuickStart Guide will help you get started using the
Linearization DesignGuide. Chapter 2, Linearization DesignGuide Reference
provides useful reference information.

Note This manual is written describing and showing access through the cascading
menu preference. If you are running the program through the selection dialog box
method, the appearance and interface will be slightly different.

The Linearization DesignGuide has many simulation set-ups and data displays that
are very useful for performing linearization of a power amplifier. The simulation
set-ups are categorized by the type of technique desired:

e FeedForward

RF Predistorter

Combined FeedForward and Predistortion
LINC

Analog Predistortion
= Cartesian Feedback
= Digital Predistortion
= Memory Effects

There are also several real-time Agilent Ptolemy simulation examples. The
simulation set-ups are for analysis and power amplifier characterizations.

Note This DesignGuide is not a complete solution for all Linearization techniques,
but covers the most common approaches. Subsequent releases of this DesignGuide
will include an expanded range of features.
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Linearization QuickStart Guide

Using DesignGuides

All DesignGuides can be accessed in the Schematic window through either cascading
menus or dialog boxes. You can configure your preferred method in the Advanced
Design System Main window. Select the DesignGuide menu.

The commands in this menu are as follows:

DesignGuide Studio Documentation > Developer Studio Documentation  is only available
on this menu if you have installed the DesignGuide Developer Studio. It brings up
the DesignGuide Developer Studio documentation. Another way to access the
Developer Studio documentation is by selecting Help > Topics and Index >
DesignGuides > DesignGuide Developer Studio (from any ADS program window).

DesignGuide Developer Studio > Start DesignGuide Studio is only available on this
menu if you have installed the DesignGuide Developer Studio. It launches the initial
Developer Studio dialog box.

Add DesignGuide brings up a directory browser in which you can add a DesignGuide
to your installation. This is primarily intended for use with DesignGuides that are
custom-built through the Developer Studio.

ListtRemove DesignGuide brings up a list of your installed DesignGuides. Select any
that you would like to uninstall and choose the Remove button.
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Preferences brings up a dialog box that allows you to:

= Disable the DesignGuide menu commands (all except Preferences) in the Main
window by unchecking this box. In the Schematic and Layout windows, the
complete DesignGuide menu and all of its commands will be removed if this box
is unchecked.

= Select your preferred interface method (cascading menus vs. dialog boxes).

—| DesignGuide Preferences |

PLEASE NOTE: Any changes made to these options require
restarting ADS to take effect.

® Show DesignGuide Menu

The DesignGuide Preferences menu will still be available
in the Main window if you hide the DesignGuide menu
in the Schematic and Layout windows.

DesignGuide Menu Style

-+ Use a selection dialog box

“# Use cascade menus

I 0K Cancel

Close and restart the program for your preference changes to take effect.

Note On PC systems, Windows resource issues might limit the use of cascading
menus. When multiple windows are open, your system could become destabilized.
Thus the dialog box menu style might be best for these situations.

Using DesignGuides 1-3
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Basic Procedures

The features and content of the Linearization DesignGuide are accessible from the
DesignGuide menu found in the ADS Schematic window.

To access the documentation for the DesignGuide, select either of the following:

= DesignGuide > Linearization > Linearization DesignGuide Documentation  (from
ADS Schematic window)

= Help > Topics and Index > DesignGuides > Linearization (from any ADS program

window)
DesignGuide

Bluetooth r o

cdma2000 b |E’.§| Iﬁhl M| $*K| RN

Filter L e 0l

Linearization Rt S (0 [l »

bdimer *  RF Predistorter »

Dzcillator ¥ Combined Feedfonward and Predistartion  # .

FPazzive Circut » LIMC »

PLL ¥ Analog Predistortion vl

Amplifier ¥ LCartesian Feedback. L

BF Suztem ¥ Digital Prediztortion »

WfLAMN ¥ Memom Effects »
Agilent Ptalemy [Demoz /T emplatesz] »

PIEZTZTEE Pawer Amplifier Characterization b

The menu selections from FeedForward to Power Amplifier Characterization each
have additional selections. The menu commands for step-by-step schematics for
FeedForward and RF Predistortion are shown here.
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Select DesignGuide > Linearization > Feedforward >Step by Step Design.

Step 1. Cancellation Loop Swept Coefficients Step by Step Design
Step 2. Cancellation Loop Coefficient Optimization Modulation

Step 3. Cancellation Loop with Complex Correlator ator

Step 4. Ausillary Amplifier Level Test ive Circuit DesignGuide
Step 5. Error Compenzation Loop Swept Coefficients

Step B. Error Compenzation Loop Coefficient Opt. lifier

Step Y. Error Compenzation Loop ACPR mir. er amplifer DesignGuide

Step 8. Double Loop ACPR min. and Comples Carrelator yztem

Select DesignGuide > Linearization > RfF Predistorter >Step by Step Design.

i LW SN =
Step 1. Swept 3rd order Palynomial Coefficients mﬁ

Step 2 Optimized Coeffizients bazed on [MD Levels radul
Step 3. Swept 3rd order Coefficients about Optirmum ive Circul
Step 4. Swept Sth order Coefficients about Optirum

Step B Gain Adjuzter Optimization with Comples Carrelator lifier

Step B. Optimized Palpnamial Coefficients with Comples Carrelatar er Amplifs
Step 7. Optimization of Coefficients and Gain Adjuster with Comples Correlatar yztem

Selecting one of these menu picks, such as Stepl. Cancellation Loop Swept
Coefficients, under Feedforward, copies a schematic into your current project.

Each schematic contains a sample power amplifier. The simulated results are
displayed in a data display file that opens automatically, after the schematic is copied
into your project. Modify the power amplifier by editing its subcircuit, or delete the
device and replace it with a different one.

The schematics can demonstrate performances that can be achieved through
linearization. The individual components such as the couplers, auxiliary amplifier,
combiners, complex correlators, etc., can be replaced by user-defined subcircuits. The
red boxes enclose parameters you should set, such as the operating frequency and
power level. After making modifications, run a simulation, using ADS, and the data
display will update. The linearization techniques generally consist of steps that you
should follow to better understand the design procedure and ultimately realize a
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linearized power amplifier. The steps are also used to demonstrate the sensitivity as
well as show various adaptation techniques.

The simulation results for Step 1 of the feedforward linearization are shown here.

FeedForward Linearization Step1 L Side E Siaral P cort -
Baszic Designizuide Instructions 0.40 ouwer Sids Errar Signal Power Contours (dBm)
1. Review | position alpha coefficient range
around minimum error signal cancellation. 0354
2. Re-gimulste 030 4
3. Save Data 028
3 c Igliogn Si I o2
rr r n 1 n 1 n
-24.00 ° anee atie ane 22.00 G‘I 0415
-26.00 [-24.00 £ 010
-28.00 L2600 < 00
30,00 ] 0.00
3200 ] o pont
me 30.00 0104
-34.00 4 200 015
= 3800 = -0.20
E L300 3 P A/ M M Y
T -35.00 4 = = R N - S = S T= B 1= N N = B S S
= F36.00 M O ¢ O O ¢ 8 @ o ;o O ih
g -40.00 4 lsson = Alpha_|
£ -42.00 z . -
o 4000 2 Upper Side Error Signal Povwer Contours (dBm)
E 4400 ] &
'g _4.00 4200 ,Ean
= 4500 ] 4400 3
5000 ] I 46 .00
5300 ] VIl L4 .00
-54.00 Al [-50.00
-56.00 4 ¥ |-52.00
-55.00 4 54 .00
-60.00 | | | | | I | 2600
20 15 10 05 00 05 10 15 20
Alpha_|
Lowver Side Errar Upper Side Error gngggé ?ggl;er
Signal, Minimum Signal, Minimum and number of
Qutput Power, dBm Quitput Povwver, dBm contour lines:
Alpha_l
ES%er =501 e
[ wumPouLires- 10

Most of the information on this data display and others is in a format that engineers
can easily understand. The visibility of equation syntaxes that should not need
modification is minimized. Information about items on a data display that you would
want to modify is enclosed in red boxes.
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Selecting Appropriate Configurations

The Linearization DesignGuide is broken up into different linearization
sub-categories, as shown in the previous sections. The specifications that you use
depend on your objective and the type of technique that your system can
accommodate. If, for example, you have a wideband power amplifier, you can start
with the FeedForward configuration at Step 1, shown here. Then proceed through the
steps until you have a better understanding of the design procedure.

FeedForward Linearization Step2
Basic DesignGuide Instructions Cptirurm &lpha_l opm\
1. Adjust spectral plot for user frequency and power range
2. Re-simulate ) _ G. 97“' I G.090
3. Save Data, make note of optimurm alpha coefficients
Fpecirum of Error Concellolion Signol l}\ Fundomgniol Error Signol wversus llerotiion Iplervaol
0.0000 5j
F -10.00 = 3
c 1
o i) 1!
= = -54!
- -70.00 o _ 1!
g e -104)
o o ] |I
T — 1
u: -30.00 } R I
° Ii ri? 3 ]
o -40.00 z 207
= b -z5
£ -50.00 o o ]
o o b
© [ER T
S -§0.00 o 5 ] Tl
= - -354
L [™) 4
-70.00 T T T —40 4 T T T T
E40.0M  BA5.0M  ES0.0M  BS55.0M  EBO.O a = 4 6 B 1a
freqg, Hz Herotion 4
Lewer Sideband Upper Hidebahnd
ml mz
Treg=849.0kHz Treq=851/0MHz
opilier=9 opiliers
dAm{verror}=-35.656 dBm({ver for}=-35.779
Optimum Alpha_l Optimum Alpha_Q

Shown in the figure is the optimization procedure based on the signal cancellation
loop. A complex gain adjuster’s parameters Alpha_I and Alpha_Q are adjusted to
minimize the fundamental components. The optimization values should be noted for
future steps.
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IMD Reduction Performance from Two-tone

Modulation

The error cancellation loop’s complex gain adjuster parameters are optimized in step
7 based on minimizing the adjacent channel power ratio. Shown here is the IMD
reduction performance that can be achieved based on a two-tone modulation. In this
figure, the spectral plots need to be adjusted to the users frequency and power
ranges. The optimum parameters for the complex gain adjuster should be noted.

FeedForward Linearization Step 7

Basic DesignGuide Instructions

1. Review, adjust spectrums to your frequency and power ranges
2. Re-simulate

3. Save Data, make note of the optimum Beta Coefﬁcwents%

Specirum ol Pa Guipul

{ dam}

Fower

a-
104
—20 -
—30 -
—40

=70

SEE—
OrE—
SrE—
0G5
S5
0ag—
S5
0Lg

Treg, MHz

i1ial Ipectirum ol Feedforword Coiput

50
40
30
204
10

a

0
—10
-70 -

Power [dBm)

SCE—
OrE—
SrE—
0oE—
CCE—
0og—
SaE—
0Lg

Treq, MHz

ptirnurm Beta_Q

-1.313
Hetio Coefficienis v7rsus Ierolion Interval
1.0
a.5
2 0.0
o -0.5
Z 1.0
I
L -1.5
-z.0 T B AAEEEE

Optlimized

o

pecirum ol FeedForward Qufpul

10 13 zZa

Ileration #

50

a0 -

il

CEE—
O E—

Sw¥E—
0SE—
SEE—
o8
S5
oLg

freg, MHz

Optimum Beta_Q

-1.313

Optimum

Beta_l
-0.252

The linearization steps have provided you with the optimum complex gain adjuster
parameters under given conditions. Those conditions are the operating frequencies of
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the tones as well as the average output power delivered by the amplifier. To proceed
to a linearized power amplifier based on a user defined modulation, the same
conditions must be satisfied.

Convergence of Optimum Parameters

It is important to ensure that the output power from the schematic shown here is the
same as that used to obtain the optimum Beta and Alpha parameters. Optimization
can be performed on the linearizer using a given modulation source. However, the
simulation would take a significant amount of time. This is why it is important to
achieve convergence on the optimum parameters through a systematic procedure.
The source can be replaced with a user-defined modulation subcircuit. Future
upgrades will contain a more in-depth list of sources.

FeedForward Linearization 1S05Rev
© . The abjectiva of this femplate i to absarve the perfarmance of the feedfomard lin when, d The | L
powerampllflersgroup delay and gajn need to “be known. The |nput|sare\rerse \lnkCDMAslgnalbased onthe \5 95 speclflcatlon Its F

s important th operate at the sama pnwerle\te\ ‘asinith the optimized paramaters

=

JnsertYou[Powgrﬁmplmal © o 6 o oo oo o oo a8 a0 s o oo oo oo oo o BT o

o o

neet Your Amplifiers  f 0 o 0o 3 1. ... o=
. o o oo o o | FeedFomvard Dutput .
@ain less 10 dBs Znd Ladp P

i e

_AstLanp,

Gomglev Grlr Ad[esier - - . S . Ce e _[‘u:nnl.!'.GD'!Aﬂlu!l!
[

o, & o
© Awillan Power Arhplifiér -

. InsertYoulAmplmers o
© Grbup Delay C

e BT i
/,h-n P N
L]

© ErortCancellation”
- - Output- - - - -

Comples Cartelatat

. Setyouroperating fraquency,
" power amplifier group delay
as el as the inpuf power ievel

- Optimum Alpha Marizbles -

. .Optimum BetaVariables.
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Feedforward Linearizer Performance Based on Reverse Link
Signal

The performance of the feedforward linearizer based on a reverse link 1S95 CDMA
signal is shown here.

Before linearization

After linearization

FeedForward Linearization 1595 Reverse Link Epectrum of Generated Signal

Real part of Modulsted RF Carrier versus Time
by

renl PeTond_oul )
o
T

-0 T T T T T T T T T =1
0 1D 2 30 40 50 &0 7D BD GO l% =(ﬂ-g_
-
lire, user 5=
Elle
[P soect rum_butoui-dim{ Ta{Viund_aui. ... "Falger" 1] B2
Specdrum_Pa=dbm{ fg{Viund_Pa, ., Kolger"il E_ﬁg
Soectrum_ Inpul=dBm{ {g{Viynd_In. ... "Koleer™1) WL%L%

Meon power, pegk oower, and peak-{g-overage
cower caleulailaong

P Foutmmean(mag (W Tund_oui**211/100

P FeokFawe r=moq{Hund_oul #2150 B ot kg o0

PP ocPeokPawer-max (PeokPower |

[P HovPeak_1o_Avg-HarPeakPawer Poul

Y Foui_dem N\iorfect o bvg ; :
30.9G65 5,122 '
M/ Lower Channel ACPR Upper Channel ACPR
to Average Powver Ratio

) % | TransACPR(1) [l TransACPR[Z)
N | -43.504 | | —45.893
* 4d [gceni-chonne | pawer colculailans

B o tn i iml fe=j-(1.7708 WHZ/21,(1.7788 WHZ/21]
P voth i imi 13885 kHz. 915 khzi
A ook imTdem§-915 LHz, 885 Lhzi

T Pl 1 oneaCPR=acRr _vr [YTund_ou!.G0.malnlIml{g.Lath | Iml 9. UaCh 1 Tml s, "Kalaer "]

PeshPsven/Panl
!

Pout_dBm
30.999

The spectral improvement is easily observed, as well as the operating output power
conditions and ACPR calculations. If improvement is not observed, you should check
the operating conditions used during the two-tone step-by-step procedure and ensure
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that they are close to those used for the modulated source. Further improvement can
be obtained by performing an optimization with the modulated source. Optimization
with a modulation source would take a significant amount of time to converge to the

optimum state but will require less iterations once we are close to the optimum

values for Alpha and Beta.

In addition to the Analog/RF simulation of various linearization techniques, there are
also real-time adaptive simulation using Agilent Ptolemy schematics. Various forms
of Feedforward linearization adaptation techniques are available, as observed in the
selection menu shown here, found under Agilent Ptolemy (Demos/ Templates.

Feedforward Demo [2-Tone, 1 Loop, ACFPR min.]
Feedforward Demo [Mulit-Tone, 1 Loop, Gradient Opt.]
Feedforward Demo [Mulit-Tone, 1 Loop, ACFR min. ]
Feedforward Demo [15-95 COMA, 1 loop, ACFR min.]
Feediarward Dema [2-Tane, 2 Loop, Gradient Opt. ]
Feedfarward Template [2-Tone, 1 Loop, ACPR min.]
Feedfarward Template [15-95 COMMA, 1 Loop, ACPR min.)
Diigital Prediztartion uzing Look-Up T able

RF Predistartion uzing *ork Function

Agilent Pralerny [C
Bawer Amplifier Cl

About Linearizatio

Linearization Desi

The demos show the stability and speed of adaptation based on Behavioral Model
Power Amplifiers. A few templates are available that use co-simulation and

incorporate a transistor level power amplifier.

IMD Reduction Performance from Two-tone Modulation
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Feedforward Linearizer Using Complex Correlator

Following is the Agilent Ptolemy schematic for a FeedForward Linearizer using a
complex correlator for both adaptive loops.

ek abpitie rdedrariord inabrtibe |4 dehadairdled Yuiny hb §ridlont bouge metrnd Tnta theknlaigidlfod o ire 1
Calgn 9110 8T -1he Aradipnl or 6 BHrTacs 19.regeh 11o minTmuh polnt s 1he.qarelient 1+ ea culoied Tn the comlew eorreloior
Blecksr The power smplifiey Lhat ig 1o be [fnealized Te based on o Mnameu glmodel . gilhsugh sne eould wasily Tevlace

T mi(h o | oot o 1T (aplce rmodet) myl fitaburs ‘b ol [ T IR T

cmireras fuilens sln could mlze be casilpoeploned DL e ol e e :D—stolaI e L e e
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The operating frequencies and power levels can be altered to better reflect your
configuration. The percentage bandwidth between the frequency spacing and center
frequency need to be scaled proportionally. Otherwise, the bandstop filter in the
second adaptive loop will need to be modified. The outputs from these Agilent
Ptolemy schematics is in the form of either storage to data files or real-time X-Y
Plots. As soon as the X-Y Plot windows open, you should pause the simulation and
arrange the plots within the window. We can observe the initial spectral state of the
FeedForward Linearizer.

Once the simulation is continued, we can observe the reduction of the
intermodulation distortion as well as the stabilization of the Alpha and Beta
coefficients. The other two plots labeled IMD_3rd and IMD_5th display the level of
3rd and 5th order intermodulation products as a function of time.
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Chapter 2: Linearization DesignGuide
Reference

The following sections provide reference information on the use of the Linearization
DesignGuide.

Using the Linearization DesignGuide

The Linearization DesignGuide is integrated into Agilent EEsof’s Advanced Design
System environment. It contains many templates to be used within ADS. These
templates can assist developers in designing a linearizer to meet performance
specifications. This Design Guide provides a complete tool Kit to interactively explore
dynamic linearization systems at the top level as part of an integrated design
process.

In addition to the requirements of the ADS software, the Linearization DesignGuide
will require approximately 30 MB of additional storage space.

Note This manual assumes that you are familiar with all of the basic ADS program
operations. For additional information, refer to the ADS User’s Guide.

The primary features of this DesignGuide include the following:

= Complete linearization capability

FeedForward (8-step design process)

FeedForward (1S-95, CDMAZ2000, pi/4 DQPSK and 16 QAM simulation)
RF predistortion (7-step design process)

RF predistortion (1S-95 CDMA, pi/4 DQPSK and 16 QAM simulation)

FeedForward combined with RF predistortion (10-step design process)

Analog Predistortion (3-step design process for Cubic Law)

= Analog Predistortion (3-step design process for Square Law)

« LINC design (5-step design process)

= LINC design (1S-95 CDMA, pi/4 DQPSK and 16 QAM simulation)

Using the Linearization DesignGuide 2-1
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= Cartesian feedback (2-step design process)
Cartesian feedback (1S-95 CDMA, pi/4 DQPSK and 16 QAM simulation)

= Digital predistortion (6-step design process)
= Digital predistortion (1S-95, CDMA2000, pi/4 DQPSK and 16 QAM simulation)
= Memory Effects (Short Time Constant simulation)

= Memory Effects (Long Time Constant: 1S-95, CDMAZ2000 and pi/4 DQPSK
simulations)

= ACPR optimization technique

= Gradient optimization technique

= Distinct Agilent Ptolemy demos

= Feedforward Agilent Ptolemy templates

= Easy modification to user-defined configurations

Linearization Techniques

Following are linearization techniques available in the DesignGuide. To access these
tools, select DesignGuide > Linearization DesignGuide from the ADS Schematic
window, and select the appropriate menu commands.

2-2 Linearization Techniques



Feedforward

The following sections provide background details on the use of Feedforward
linearization.

) Phase hdain  Power
“weriable Sampling Output

Shift Amplifi Diel
Atenuation ' pimer Coupler bl Coupler

e Hp—=—o —

RF
Output

RF é Fixed
input _<) Splitter Atenuation

Delay

©
Coupler Auxillary, Amplifier

Fhase
Shift

“wariable
Attenuation

Signal Cancellation aap Errar Cancellation .ogp

Figure 2-1. Feedforward Linearizer

Increasing demand for spectral efficiency in radio communications makes multilevel
linear modulation schemes such as Quadrature Amplitude Modulation more and
more attractive. Since their envelopes fluctuate, these schemes are more sensitive to
power amplifier nonlinearities, the major contributor of nonlinear distortion in a
microwave transmitter. An obvious solution is to operate the power amplifier in the
linear region where the average output power is much smaller than the amplifier's
saturation power (i.e., Larger output back-off). But this increases both cost and
inefficiency as more stages are required in the amplifier to maintain a given level of
power transmitted. Thus greater DC power is consumed. Power efficiency is certainly
a critical consideration in portable systems where batteries are often used or in small
enclosures where heat dissipation is a problem. Another approach to reducing
nonlinear distortion is the linearization of the power amplifier.
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The power amplifier's characteristics tend to drift with time, due to temperature
changes, voltage variations, channel changes, aging, etc. Therefore a robust linearizer
should incorporate some form of adaptation.

In 1927, H.S. Black of Bell Telephone Laboratories invented the concept of negative
feedback as a method of linearizing amplifiers. His idea for feedforward was simple:
reduce the amplifier output to the same level as the input and subtract one from the
other to leave only the distortion generated by the amplifier. Amplify the distortion
with a separate amplifier, then subtract it from the original amplifier output to leave
only a linearly amplifier version of the input signal.

Feedforward Configuration

The feedforward configuration consists of two circuits, the signal cancellation circuit
and the error cancellation circuit. The purpose of the signal cancellation circuit is to
suppress the reference signal from the main power amplifier output signal, leaving
only amplifier distortion, both linear and nonlinear, in the error signal. Linear
distortion is due to deviations of the amplifier's frequency response from the flat gain
and linear phase. Distortion from memory effects can be compensated by the
feedforward technique, since these effects will be included in the error signal. The
values of the sampling coupler and fixed attenuation are chosen to match the gain of
the main amplifier. The variable attenuation serves the fining tuning function of
precisely matching the level of the PA output to the reference.

The variable phase shifter is adjusted to place the PA output in anti-phase with the
reference. The delay line in the reference branch, necessary for wide bandwidth
operation, compensates for the group delay of the main amplifier by time aligning the
PA output and reference signals before combining. The purpose of the error
cancellation circuit is to suppress the distortion component of the PA output signal,
leaving only the linearly amplifier component in the linearizer output signal. In order
to suppress the error signal, the gain of the error amplifier is chosen to match the
sum of the values of the sampling coupler, fixed attenuator, and output coupler so
that the error signal is increased to approximately the same level as the distortion
component of the PA output signal.
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Adaptation Techniques
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Figure 2-2. Adaptive Feedforward Linearization

Several patents concerned with adaptive feedforward systems appeared in the
mid-"80’s, and many more appeared in the early '90’s. These patents dealt with two
general methods of adaptation both with and without the use of pilot tones, namely
adaptation based on power minimization and adaptation based on gradient signals.
The control scheme for the former attempts to adjust the complex vector modulator in
the signal cancellation circuit so as to minimize the measured power of the error
signal in the frequency band occupied by the reference signal. In the error
cancellation circuit, the frequency band is chosen to include only that occupied by the
distortion. Once the optimum parameters have been achieved, deliberate
perturbations are required to continuously update the coefficients. These
perturbations reduce the IMD suppression.

Adaptation using gradient signals is based on continually computing estimates of the
gradient of a 3-dimensional power surface. The surface for the signal cancellation
circuit is the power in the error signal. This power is minimized when the reference
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signal is completely suppressed, leaving only distortion. The surface for the error
cancellation circuit is the power in the linearizer output signal. The power is
minimized when the distortion is completely suppressed from the Power Amplifier
output signal. The gradient is continually being computed and therefore no deliberate
misadjustment is required.

The ACPR minimization approach uses a frequency translator plus a power detector
to select and measure the ACPR. The bandpass filter will capture the adjacent
channel power. Care must be taken to ensure that the fundamental signal is rejected.
The Digital Signal Processor performs the adaptation of the work function
coefficients based on the scalar value input from the power detector.

The input signals for the complex correlator are the error signal and the reference
signal. The error signal is derived by subtracting the input signal from the power
amplifier's output signal. The error signal, if properly aligned, should contain only
the resulting distortion generated by the power amplifier. The reference signal is the
input to the Feedforward linearizer. The objective of the correlator is to optimize the
complex gain adjuster so as to ensure that the two signals are uncorrelated.

Complex Gain Adjusters

The complex gain adjuster can take on two forms: Polar or Rectangular
Implementation. The polar representation requires a voltage-controlled attenuator
and phase shifter. The rectangular implementation is of the same form as a
guadrature modulator. Either of these configurations need to operate in the linear
region where the generated intermodulation products are significantly lower than
those generated by the power amplifier. The complex gain adjusters are required to
be insensitive to variations across the operational bandwidth.

RF Predistortion

The linearizer creates a predistorted version of the desired modulation. The
predistorter consists of a complex gain adjuster, which controls the amplitude and
phase of the input signal. The amount of predistortion is controlled by two nonlinear
work functions that interpolate the AM/AM and AM/PM nonlinearities of the power
amplifier. Note that the envelope of the input signal is an input to the work functions.
The function of the envelope detector is to extract the amplitude modulation of the
input RF signal. The delay line in the upper branch compensates for the time delay
that occurs as the envelope passes through the work function. Once optimized, the
complex gain adjuster provides the inverse nonlinear characteristics to that of the
power amplifier. Ideally the intermodulation products will be of equal amplitude but
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in anti-phase to those created as the two tones pass through the power amplifier. The
out-of-band filter will sample the adjacent power interference (ACPI). The function of
the DSP is to slowly adapt the work function parameters so that the ACPI is
minimized.

Adaptation Techniques

Several patents concerned with adaptive predistortion systems appeared in the
mid-'80’s, and many more appeared in the early ‘90's. These patents dealt with two
general methods of adaptation, namely adaptation based on power minimization and
adaptation based on gradient signals. The control scheme for the former attempts to
adjust the complex gain adjuster in such a way as to minimize the measured power of
the error signal in the out-of-band frequency. Once the optimum parameters have
been achieved, deliberate perturbations are required to continuously update the
coefficients. These perturbations reduce the IMD suppression. Adaptation using
gradient signals is based on continually computing estimates of the gradient of a
3-dimensional power surface. The surface for the RF predistorter circuit is the
difference between the input signal and the scaled output signal. This power is
minimized when the error signal is completely suppressed. The gradient is
continually being computed and therefore no deliberate misadjustment is required.

Work Function

The work function can take on various mathematical forms. The simplest to
implement is the polynomial representation, whereby the coefficients are adapted to
create the inverse nonlinearity to that of the power amplifier. The work
function-based predistorter has limited capability in reducing the level of
intermodulation distortion. The envelope modulation is the input parameter for
generating the complex gain function.

FeedForward Combined with RF Predistorter

An RF Predistorter is embedded in the signal cancellation loop of a FeedForward
linearizer. The predistorter consists of a complex gain adjuster, which controls the
amplitude and phase of the input signal. The predistorter is based on a work function
that interpolates the inverse AM/AM and AM/PM nonlinearities of the power
amplifier. An envelope detector is used to extract the incoming amplitude
modulation, this signal is then used as an input into the work function. The error
signal from the signal cancellation loop of the FeedForward linearizer is used to
adapt the predistorter coefficients.
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The advantages of embedding a RF Predistorter inside a FeedForward Linearizer are
that the Intermodulation reduction requirements of the FeedForward Loop alone are
reduced. This will reduce the component sensitivities across the band of frequencies.
The net result is the overall efficiency improvement of the power amplifier.

There are several techniques for guiding the adaptation of the FeedForward
Linearizer. The most commonly used has been the employment of Pilot Tones for
optimizing the complex gain adjuster coefficients in both loops. A Pilot Tone can be
injected at the input of the FeedForward Linearizer and then monitored at the output
of the signal cancellation loop. The first Pilot Tone will ensure that the signal
cancellation loop achieves optimum reduction of the fundamental component. The
residual signal will contain only the distortion created by the power amplifier. A
second Pilot can be injected in the upper branch of the first loop and monitored at the
output of the FeedForward linearizer. The second Pilot Tone will be used to ensure
that the error cancellation loop achieves optimum reduction of the power amplifier’s
distortion. Other techniques such as power minimization and signal correlation can
also be used in combination with Pilot Tones. These have been discussed in the
FeedForward Linearizer section.

Also a number of techniques exist for adapting the RF Predistorter. These have been
discussed in the RF predistortion section. The advantage of embedding an RF
Predistorter inside the Feedforward Linearizer is that the resultant error signal from
the first loop can be used to optimize the RF predistorter work function.
Minimization of the adjacent channel power at the error port is an effective technique
for optimizing the work function coefficients.

Analog Predistortion

Predistortion linearization involves constructing a predistorter which has the inverse
non-linear characteristics of the power amplifier. Therefore, when the predistorter’s
output signal is passed through the power amplifier, the distortion components cancel
and only the linear components remain. The type of analog predistorter to use is
dependent on the nonlinearities generated by the power amplifier. Analog
predistorters can be constructed as Square Law or Cubic Law devices or any
combination of these two configurations. Typically diodes arranged in various
configurations are used to generate the second and third order distorters. For Square
Law devices, two diodes are arranged so that the even terms of an equivalent series
expansion add together and the odd terms cancel. The opposite is true for the Cubic
law devices. An advantage of using diodes is the ability to predistorter over a wide
bandwidth. Some of the disadvantages are the power and temperature dependence as
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well as the inaccuracy in controlling the constructed nonlinearity. Which ultimately
leads to a limitation on the amount of IMD reduction achieveable.

An analog predistorter generally has two paths. One carries the fundamental
components and the other is the distortion generator. The objectives are the
elimination of the fundamental component in the distortion generator path, thereby
providing independent control of the distortion relative to the fundamental
component. The two paths are time-aligned and then subsequently combined before
being presented to the power amplifier.

LINC

Linear amplification using nonlinear components (LINC) is a technique whereby a
linear modulation signal is converted into two constant envelope signals that are
independently amplified by power-efficient Class C amplifiers and then combined
using a hybrid coupler. The use of power-efficient amplifiers can provide significant
improvement in the PAE of the overall system. The envelope conversion operation is
a nonlinear process that generates spectral components outside of the modulation
bandwidth. Any imbalance between the two Class C amplifiers needs to be
eliminated. Otherwise significant ACPI will be generated. A complex gain adjuster
can be inserted into one of the branches to adaptively control the balance between the
amplifiers. The adaptation process can use either the ACPR minimization approach
or the Gradient based correlator approach.

Cartesian Feedback

Cartesian feedback is based on the classical feedback control system. An error signal
is created by subtracting the power amplifier's output from that of the input signal.
This error signal is the input to the power amplifier. The limitations of the cartesian
feedback linearizer are the achievable bandwidth and system stability. The
operational bandwidth is controlled by the amount of delay in the feedback path and
the stability is a function of the feedback gain.

Digital Predistortion

The two most common digital predistortion techniques are the Vector mapping
look-up table approach and the Complex gain look-up table approach. The Vector
mapping technique stores a compensation Vector into a look-up table for each input
signal vector. This approach tends to require a large amount of data storage. The
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complex gain approach is similar to predistortion whereby the inverse nonlinearity is
generated in a look-up table. However, the look-up table provides for a more accurate
representation of the inverse nonlinearity. The look-up table is indexed by either
magnitude or power. The latter requires less LUT entries and can provide similar
intermodulation improvement if the nonlinearity created by the power amplifier is
minimal at low levels of input modulation. The resultant error signal generated by
subtracting the power amplifier output from the input signal is used to optimize the
LUT entries. An adaptive delay is used to properly align the two signals.

Adaptation Using Linear Convergence

Various adaptive algorithms are available that trade speed of convergence with
robustness. The simplest of these is linear convergence, whereby the LUT entries are
adapted incrementally. The incremental adjustment is proportional to the error
vectors magnitude and phase. Some techniques require transformations between
polar and rectangular coordinates.

Memory Effects

Electrical memory effects are caused by varying impedances across the modulation
bandwidth. The frequency dependence of the source and load impedances cannot be
kept constant for all modulation frequencies. The amplitude and phase of the
intermodulation products are dependent on the frequency dependent behavior of the
impedances. Careful design of the bias networks can reduce the electrical memory
effects. A two-tone simulation can demonstrate the modulation frequency dependence
on the 3rd and 5th order IMD products.

Thermal power feedback causes memory effects at low modulation frequencies.
Increased power dissipation causes the power amplifier device’s junction temperature
to increase which in turn alters the amplifier's gain. These memory effects are
observed as the envelope varies over time. Modelling these long time constant effects
requires a form of thermal power feedback.
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Analog/RF Examples

The following sections provide details on the Analog/RF examples.To access these
examples, select DesignGuide > Linearization DesignGuide from the ADS Schematic
window, and select the appropriate example.

Feedforward

Step 7 in the Feedforward menu is an example of a feedforward linearizer. The first
loop consists of a power amplifier and a complex gain adjuster, which is adjusted
using a complex correlator. The power amplifier is a transistor level design, which is
easily replaced by the user-defined component. The input power level as well as the
input frequency needs to be set. The power amplifier group delay needs to be
compensated on the lower branch of the first loop. The second loop consists of an
auxiliary amplifier along with a complex gain adjuster, which is optimized using the
ACPR minimization technique. If a transistor level auxiliary amplifier is being used,
the upper branch of the second loop also needs to have a compensating group delay.

The feedforward design consists of an 8-step process to develop a double loop
structure. The design process begins with an optimization of the first loop and
subsequent designs build on this structure. Once the complete feedforward structure
has been developed, the two-tone input can be replaced by the user-defined input
modulation. Examples are included for an 1S-95 CDMA signal, 16 QAM signal as well
as a pi/4 DQPSK signal.

The simulation results from the 8t step of the feedforward linearizer demonstrate
the optimization that can be achieved using a two-tone input. The optimization
algorithm can be changed to reflect the adaptation process to be used in the user
defined system.

RF Predistorter

Step 5 in the RF Predistorter menu is a 5th-order polynomial work function based RF
predistorter. The adaptation technique is based on the gradient approach using a
complex correlator. The output signal from the power amplifier is subtracted from the
input reference signal. If properly aligned, the resultant error signal will consist of
only the distortion generated by the power amplifier. The work function coefficients
can then be optimized so as to minimize the error signal. The input to the work
function is the squared envelope of the incoming signal. A group delay is required to
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compensate for the delay from the envelope detector, and a delay is required in the
feedback path to compensate for the delay from the upper branch.

The RF Predistorter design consists of a 7-step process to develop a gradient-based
optimized structure. The design process begins with an optimization using the ACPR
minimization technique and subsequent designs build on this structure. Once the
complete RF Predistorter structure has been developed, the two-tone input can be
replaced by the user-defined input modulation. Examples are included for a 16 QAM
signal, 1S-95 CDMA signal, as well as a pi/4 DQPSK signal.

FeedForward combined with RF Predistorter

Step 10 in the Feedforward with RF Predistorter menu is an example of a
feedforward linearizer with an embedded RF predistorter. The first loop consists of a
power amplifier and a complex gain adjuster, which is adjusted using a complex
correlator. The power amplifier is a transistor level design, which is easily replaced
by the user-defined component. The input power level as well as the input frequency
need to be set. The power amplifier group delay needs to be compensated on the lower
branch of the first loop. Also incorporated in this loop is a work function based RF
Predistorter. The optimization of the RF Predistorter is easiest achieved by
minimizing the ACPR at the error port. The second loop consists of an auxiliary
amplifier along with a complex gain adjuster, which is optimized using the Pilot Tone
approach. If a transistor level auxiliary amplifier is being used, the upper branch of
the second loop also needs to have a compensating group delay.

The feedforward combined with RF Predistorter design consists of a 10-step process
to develop a double-loop structure. The design process begins with an optimization of
the first loop and subsequent designs build on this structure. Once the complete
structure has been developed, the two-tone input can be replaced by the user-defined
input modulation.

The optimization algorithm can be changed to reflect the adaptation process to be
used in the user-defined system.

Analog Predistortion

The Analog Predistorter consists of a 3-Step Cubic Law process and a 3-Step Square
law process. Both predistorters are based on using diodes in various configurations to
generate the distortion. The diodes can be biased to better approximate the type of
nonlinear behavior that is required. The predistorters consist of two paths; one to
generate the nonlinearity and the other to pass the fundamental components. A
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hybrid is used in the distortion generation path for eliminating the fundamental
component. A complex gain adjuster is then used to control the amplitude and phase
of the distortion relative to the fundamental component.

The square law device optimizes the bias voltage to reduce any third order
nonlinearity. The impedance in the 4th port of the hybrid is adjusted in order to
eliminate the fundamental component at the output of the hybrid. Step 3 of the
analog cubic law predistorter is an example of the predistortion of a power amplifier.

The cubic law device is not biased in this configuration. It consists of two anti-parallel
diodes to create the cubic behavior. A hybrid is also used in this distorter to eliminate
the fundamental component.Step 3 of the analog square law predistorter is an
example of the predistortion of a power amplifier.

LINC

Linear amplification using nonlinear components (LINC) consists of Class C power
amplifiers along with a nonlinear operation that converts the fluctuating envelope
into a constant amplitude envelope. The conversion process is honlinear and
subsequently generates a significant amount of spectral spreading. The hybrid
combiner at the output eliminates the out-of-band components. However, any
misalignment between the two Class C amplifiers will result in some residual
out-of-band components.

The LINC design consists of a 5-step process to develop an ACPR minimization-based
optimized structure. The design process begins with an optimization with a two-tone
input and subsequent designs build on this structure. Once the complete LINC
structure has been developed, the two-tone input can be replaced by the user-defined
input modulation. An example is included for a 16 QAM, 1S95 CDMA and a pi/4
DQPSK signal.

The simulation results for LINC using a pi/4 DQPSK modulation demonstrate the
ACPR performance of the power amplifier. The results show how the nonlinear
transformation converts the linear modulation into two constant envelope
modulations. The resultant frequency spreading into the adjacent channel is also
observed. Upon combining, the output signal is reconstructed and has recovered the
proper levels of adjacent channel interference.

Analog/RF Examples 2-13



Linearization DesignGuide Reference

Cartesian Feedback

The cartesian feedback linearizer consists of a power amplifier along with a
guadrature modulator and demodulator. The feedback error signal is created by
subtracting the baseband input signal from the power amplifier's demodulated
output signal. The transistor level power amplifier can be replaced by a user-defined
component.

The demodulated | and Q signals at the output of the power amplifier are fed back to
the summing input of the comparator/filter circuit, after a 180-degree phase shift.
The comparator/filter circuit will predistort its output to maintain a virtual ground at
the comparator summing node. This will occur when both inputs to the
comparator/filter circuit are in phase for an open loop. When the loop is closed, the
input to the comparator/filter circuit will be equal but in opposite phase.

To get loop stability, the comparator/filter circuit uses a lowpass filter to limit the loop
bandwidth. The cutoff frequency must be sufficiently wider than the bandwidth
spread due to the amplifier nonlinearity. Linearity is limited by two factors, the loop
gain and the accuracy of the feedback path. The loop gain has to be as large as
possible, but is limited by the loop stability, which in turn is closely dependent on the
phase response. Adjustment of the phase shifter is critical. With the loop opened, the
phase should be adjusted so that there is no phase rotation of the demodulated | and
Q signals with respect to the | and Q signals at the input of the comparator/filter
circuit.

The optimization process for the cartesian feedback system is demonstrated. The
relative improvement in the level of ACPR can be measured by comparing the open
and closed loop responses. An example is included for a 16 QAM, 1S95 CDMA and a
pi/4 DQPSK signal.

Digital Predistortion

The digital predistorter consists of a complex gain adjuster along with a
polynomial-based work function. The standard look-up table has been replaced by a
work function for demonstration purposes. One of the key features that is included
using this structure is the quantization noise introduced by the A to D. The number
of bits of the A/D will determine the size of the Look-Up Table. The polynomial
structure can be used to fit the LUT entries in a DSP implementation.

The output of the power amplifier is subtracted from the input reference, resulting in
an error signal that should contain only distortion, if properly aligned. The resultant
error signal would be used to update the LUT entries or equivalently the polynomial
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coefficients. An example is included for a 16 QAM, 1S95, CDMA2000 and a pi/4
DQPSK signal.

Memory Effects

The electrical memory effects of a power amplifier are observed in the Short Time
Constant example. A two tone test is performed in which the frequency spacing is
altered. The modulation frequency dependence on the 3rd and 5th order
intermodulation products can be observed. Any asymmetry in the lower and upper
sideband IMD products will limit the amount of predistortion improvement that is
achieveable.

The thermal memory effects can be observed for various input modulations. The
ACPR is plotted as a function of the memory delay. Examples are included for 1S-95,
CDMAZ2000 and pi/4 DQPSK. A thermal memory effect compensator is demonstrated
for various input modulations.

Agilent Ptolemy Examples

The following sections provide details on the Agilent Ptolemy examples. To access
these examples, select DesignGuide > Linearization DesignGuide> Agilent Ptolemy
(Demos/Templates) from the ADS Schematic window, and select the appropriate
example.

Feedforward

The single adaptive loop Agilent Ptolemy example includes a multi-tone input. This
example demonstrates a fast rate of convergence because of the gradient based
optimization technique.

A number of feedforward configurations are developed in Agilent Ptolemy. The 1St
and 2"d Joops can be optimized using either complex correlators or the ACPR
minimization technique. Some of the demos store the data while others open windows
to observe the adaptation process. A couple of templates use transistor level power
amplifiers you can replace these with your own power amplifiers.

The single loop feedforward linearizer performance is demonstrated in this example.
The adaptation process is very fast because of the use of the gradient technique. The
gradient technique is based on using a complex correlator. The initial
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intermodulation products are at -25 dBc, then are quickly reduced to a final state
level of approximately -80 dBc.

This example is a real-time demonstration of the convergence of a RF Predistorter
based on the ACPR minimization technique. The work function is a 5th-order
polynomial that is fed by the envelope of the input signal. The adaptation algorithm
is based on the secant method, whereby an approximation for the derivatives of the
ACPR with respect to the work function coefficients is calculated. The work function
consists of a 5th-order polynomial which is a function of the input signal envelope.

Digital Predistorter

This example is a real-time demonstration of the convergence of a digital predistorter
based on the linear convergence technique. The envelope of the input signal indexes
the RAM look-up tables. The look-up table entries are fed to the complex gain
adjuster. In this particular configuration, the data registers and RAM tables need
proper triggering to ensure that the data is valid before being written or read. The
error signal is derived by subtracting the input reference signal from the power
amplifier’s output. This error signal is used to update the look-up tables using a
linear convergence technique.

RF Predistortion

The linearizer creates a predistorted version of the modulated signal. The
predistorter consists of a complex gain adjuster which controls the amplitude and
phase of the input signal. The amount of predistortion is controlled by two nonlinear
work functions that interpolate the AM/AM and AM/PM nonlinearities of the power
amplifier. The feedback path samples a portion of the undesired spectrum (ACPR)
which is minimized by optimizing the polynomial work function coefficients. The four
coefficients of the polynomial control the cubic and quintic nonlinearities. These
coefficients are slowly optimized using a discrete implementation of a least mean
squared direct search technique.

Reference

The following sections provide useful reference information for the Linearization
DesignGuide.
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Template Reference Guide

Following are the available templates in the Linearization DesignGuide.

Feedforward Linearization

FF_stepl (Signal Cancellation Loop Contours)

FF_step2 (Optimization of Coefficients in Signal Cancellation Loop)
FF_step3 (Optimization of Coefficients using Complex Correlator)

FF_step4 (Adjustment of Error Cancellation Loop Gain)

FF_step5 (Optimization of Coefficients for Error Cancellation Loop)
FF_step6 (Optimization of 2nd Loop Coefficients using 3rd-order IMD Minimization)
FF_step7 (Optimization of 2nd Loop Coefficients using ACPR Minimization)
FF_step8 (Optimization of Coefficients using ACPR Minimization)
FF_16QAM (ACPR Performance with 16 QAM Signal)

FF_16QAMopt (ACPR Optimization with 16 QAM Signal)
FF_CDMA2000Rev (ACPR Performance with CDMA2000 Signal)
FF_IS95Rev (ACPR Performance with 1S95 CDMA Signal)

FF_IS95Revopt (ACPR Optimization with 1S95 CDMA Signal)
FF_Pi4DQPSK (ACPR Performance with Pi/4 DQPSK Signal)
FF_Pi4DQPSKopt (ACPR Optimization with Pi/4 DQPSK Signal)

RF Predistorter

RFPred_stepl (Contour Plot of 3rd-order Coefficients)

RFPred_step2 (Optimization of Coefficients based on IMD Reduction)
RFPred_step (3rd-order Coefficient Sensitivity about Optimum)
RFPred_step4 (5th-order Coefficient Sensitivity about Optimum)
RFPred_step5 (Signal Cancellation Loop Optimization)
RFPred_step6 (IMD Optimization using Signal Cancellation Loop)

RFPred_step7 (Error Minimization using Signal Cancellation Loop)
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RFPred_16QAM (ACPR Performance with 16 QAM Signal)
RFPred_IS95Rev (ACPR Performance with 1S-95 CDMA Signal)
RFPred_Pi4dDQPSK (ACPR Performance with pi/4 DQPSK Signal)

FeedForward combined with RF Predistorter
FF_with_RFPred_stepl (Linear Coefficients Optimization using Complex Correlator)

FF_with_RFPred_step2 (Nonlinear Coefficients Optimization using Power
Minimization)

FF_with_RFPred_step2a (Linear and Nonlinear Coefficients Optimization at Error
Port)

FF_with_RFPred_step3 (Pilot Tone Optimization in Signal Cancellation loop)
FF_with_RFPred_step4 (Pilot Tone and IMD Power Minimization at Error Port)
FF_with_RFPred_step5 (Pilot Tone Optimization in Error Cancellation loop)

FF_with_RFPred_step6 (Two Pilot Tones used for Optimization of Linear
Coefficients)

FF_with_RFPred_step7 (Two Pilot Tones Optimization and IMD Power
Minimization)

FF_with_RFPred_step8 (Output Pilot Tone Removal using Re-injected Pilot at Error
Port)

FF_with_RFPred_step9 (Coefficients Optimization using 2 Pilot Tones and
Re-injected Pilot)

FF_with_RFPred_stepl0 (Pilot Tones and Re-injected Pilot Tone and IMD Power
Optimization)

Analog Predistortion

Analog_CubicPred_stepl (Optimization of Cubic predistorter)

Analog_CubicPred_step2 (Power and Frequency Dependence of Cubic Law
Predistorter)

Analog_CubicPred_step3 (Cubic Law Predistortion of Power Amplifier)

Analog_SquarePred_stepl (Square Law Predistorter Dependence on Power and Bias
Voltage)
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Analog_SquarePred_step2 (Optimization of Square Law Predistorter)

Analog_SquarePred_step3 (Square Law Predistortion of Power Amplifier)

LINC

LINC_stepl (Demonstration of Spectral Characteristics)
LINC_step2 (Demonstration of Performance Sensitivity)
LINC_step3 (Swept Complex Gain Adjuster Coefficients)
LINC_step4 (Optimized Complex Gain Adjuster Coefficients)
LINC step5 (ACPR Minimization with Complex Gain Adjuster)
LINC_16QAM (ACPR Performance with 16 QAM Signal)
LINC_IS95Rev (ACPR Performance with 1S95 Rev. Link Signal)
LINC_Pi4DQPSK (ACPR Performance with pi/4 DQPSK Signal)

Cartesian Feedback

CartesianFBoff_16QAM (ACPR Performance Open Loop)
CartesianFBon_16QAM (ACPR Performance Closed Loop)
CartesianFBoff_Pi4DQPSK (ACPR Performance Open Loop)
CartesianFBon_Pi4DQPSK (ACPR Performance Closed Loop)
CartesianFBoff_1S95Rev (ACPR Performance Open Loop)
CartesianFBon_IS95Rev (ACPR Performance Closed Loop)

Digital Predistortion

DigPred_stepl (AM/AM and AM/PM Compensation Function)
DigPred_step2 (Finite Look-Up Table Size)

DigPred_step3 (Complex Correlator Optimization of Linear Coefficients)
DigPred_step4 (Optimization of Predistorter Based on Error Minimization)
DigPred_step5 (Optimization of Linear Coefficients using a Pilot Tone)
DigPred_step6 (Optimization of Linear and Nonlinear Coefficients)
DigPred_16QAM (ACPR Performance)

Reference 2-19



Linearization DesignGuide Reference

DigPred_Pi4DQPSK (ACPR Performance)
DigPred_IS95Rev (ACPR Performance)
DigPred_CDMA2000 (ACPR Performance)

Memory Effects

Memory_Effects STC (Electrical Memory Effects, 2 Tone Simulation)
Memory_Effects LTC_CDMAZ2000 (Thermal Memory Effects, CDMA2000 Input)
Memory_Effects LTC_1S95 (Thermal Memory Effects, 1S-95 CDMA Input)
Memory_Effects LTC Pi4DQPSK (Thermal Memory Effects, Pi/4 DQPSK Input)

Memory_Comp_LTC_CDMA2000 (Thermal Memory Compensation, COMA2000
Input)

Memory_Comp_LTC_1S95 (Thermal Memory Compensation, 1S-95 Input)
Memory_Comp_LTC_Pi4DQPSK (Thermal Memory Compensation, Pi/4 DQPSK
Input)

Agilent Ptolemy

FFD_PM_2T_SL (Two-Tone Input, Single Loop, ACPR Minimization)
FFD_GD_MT_SL (Multi-Tone Input, Single Loop, Gradient Optimization)
FFD_PM_2T_SL (Multi-Tone Input, Single Loop, ACPR Minimization)
FFD_PM_95 SL (1S-95 CDMA Input, Single Loop, ACPR Minimization)
Demo_FeedForward (Two-Tone Input, Double Loop, Gradient Optimization)
FFT_PM_2T_SL (Two-Tone Input, Single Loop, ACPR Minimization)
FFT_PM_95_ SL (I1S-95 CDMA Input, Single Loop, ACPR Minimization)
WorkFunct_real_PA_Demo (RF Predistortion Demo)

DPLUT_idealPA (Digital Predistortion Demo)

Parameter Definitions

[RFfreq] RF frequency (MHz): The center frequency of the operational bandwidth.
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[Delta] the frequency spacing of a two tone signal (MHz): One half the frequency
separation for a two-tone input signal.

[Alpha_I] Complex gain adjuster In-phase control: The in-phase control parameter of
the complex gain adjuster in the first loop.

[Alpha_Q ] Complex gain adjuster Quadrature-phase control: The quadrature-phase
control parameter of the complex gain adjuster in the first loop.

[Group_Delay] Group Delay (ns): The power amplifier group delay compensation.

[V_GB] quadrature output of complex correlator: The complex correlator output from
the quadrature branch.

[V_GA] in-phase output of complex correlator: The complex correlator output from the
in-phase branch.

[Beta_I] Complex gain adjuster In-phase control: The in-phase control parameter of
the complex gain adjuster in the second loop.

[Beta_Q] Complex gain adjuster Quadrature-phase control: The quadrature-phase
control parameter of the complex gain adjuster in the second loop.

[LOfreq ] LO frequency (MHz): The frequency translation of the ACPR minimization
converter.

[Pout_dBcIMD] Carrier to 3rd-order IMD: The output carrier to 3rd-order
intermodulation power at the output.

[Pout_dBcIMDL] Lower Carrier to 3rd-order IMD: The lower output carrier to
3rd-order intermodulation power at the output.

[Pout_dBcIMDU] Upper Carrier to 3rd-order IMD: The upper output carrier to
3rd-order intermodulation power at the output.

[P_IFoutL] IF output power of lower 3rd-order IMD: The lower sideband power of the
3rd-order intermodulation product from the ACPR minimization converter.

[P_IFoutU] IF output power of upper 3rd-order IMD: The upper sideband power of the
3rd-order intermodulation product from the ACPR minimization converter.

[tstep] step time: The envelope simulation time step.
[tstop] stop time: The envelope simulation stop time.
[numSymbols] number of symbols: The number of symbols in the envelope simulation.

[sam_per_bit] samples per bit: The number of samples that represent each bit.
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[bit_rate] bit rate: The bit rate for the envelope simulation.
[PAE] power added efficiency: The power-added efficiency of the power amplifier.

[Pavs_Watts] average input power (watts): The average input power to the linearizer
in watts.

[Pdc] DC input power: The average DC power consumption of the power amplifier.

[ChannelPower_dBm] output channel power (dBm): The output power from the
linearizer in dBm.

[TransACPR] adjacent channel power ratio at linearizer output: The power ratio
between the main channel and the adjacent channels.

[TransACPR_PA] adjacent channel power ratio at power amplifier output: The power
ratio between the main channel and the adjacent channels.

[mainlimits] frequency limits of the main channel: The frequency limits of the main
channel.

[UpChlimits] frequency limits of the upper channel: The frequency limits of the upper
channel.

[LoChlimits] frequency limits of the lower channel: The frequency limits of the lower
channel.

[numpts] number of points: The number of symbols used in the envelope simulation.

[sam_per_sym] samples per symbol: The number of samples per symbol used in the
envelope simulation.

[Z_s] input power source impedance: The impedance of the input power source.

[filt_delay_syms] number of symbol delays in shaping filter: The number of symbols of
delay in the input shaping filter.

[sym_rate] symbol rate: The symbol rate in the envelope simulation.

[Alpha_3rd] 3rd-order work function real coefficient: The 3rd-order real coefficient for
the polynomial work function.

[Alpha_5th] 5th-order work function real coefficient: The 5th-order real coefficient for
the polynomial work function.

[Alpha_7th] 7th-order work function real coefficient: The 7th-order real coefficient for
the polynomial work function.
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[Beta_3rd] 3rd-order work function imaginary coefficient: The 3rd-order imaginary
coefficient for the polynomial work function.

[Beta_5th] 5th-order work function imaginary coefficient: The 5th-order imaginary
coefficient for the polynomial work function.

[Beta_7th] 7th-order work function imaginary coefficient: The 7th-order imaginary
coefficient for the polynomial work function.

[P_IMD] intermodulation power: The amount of intermodulation power.

[P_IMD3rd_L] 3rd-order intermodulation power of lower sideband: The level of the
3rd-order intermodulation power of the lower sideband.

[P_IMD3rd_U] 3rd-order intermodulation power of upper sideband: The level of the
3rd-order intermodulation power of the upper sideband.

[P_IMD5th_L] 5th-order intermodulation power of lower sideband: The level of the
5th-order intermodulation power of the lower sideband.

[P_IMD5th_U] 5th-order intermodulation power of upper sideband: The level of the
5th-order intermodulation power of the upper sideband.

[P_IMD7th_L] 7th-order intermodulation power of lower sideband: The level of the
7th-order intermodulation power of the lower sideband.

[P_IMD7th_U] 7th-order intermodulation power of upper sideband: The level of the
7th-order intermodulation power of the upper sideband.

[Group_Delay PA] power amplifier group delay: The group delay of the power
amplifier.

[spacing] two tone frequency spacing: The frequency separation value between the
two tones at the input to the linearizer.

[rmax] maximum voltage at the input: The maximum voltage excursion at the input of
the linearizer.

[Delta_Gain] differential gain: The gain imbalance between amplifiers.
[Delta_Phase] differential phase: The phase imbalance between amplifiers.
[Pavs_in] average source input power: The source average input power.

[our_ctm] carrier to 3rd-order IMD: The carrier to 3rd-order intermodulation level.

[V_IFoutL] IF output voltage of lower 3rd-order IMD: The lower sideband voltage of
the 3rd-order intermodulation product from the ACPR minimization converter.
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[V_IFoutU] IF output voltage of upper 3rd-order IMD: The upper sideband voltage of
the 3rd-order intermodulation product from the ACPR minimization converter.

[RFpwr] RF input power: The RF input power.

[Filter_delay syms] pulse shaping filter symbol delay: The number of symbol delays in
the pulse shaping filter.

[vdd] drain voltage: The power amplifier drain supply voltage.
[vbaseband] baseband input voltage: The baseband modulation voltage.
[fbaseband] baseband modulation frequency: Te baseband modulation frequency.

[extrapts] extra points in simulation: The number of additional symbols in the
envelope simulation.

[Start_Freq] start frequency for sweep: The start frequency for the simulation.
[Stop_Freq] stop frequency for sweep: The stop frequency for the simulation.
[Step_Freq] step frequency for sweep: The step frequency for the simulation.
[our_pgain] power gain of amplifier: The power amplifier power gain profile.
[our_dlp] linear phase deviation: The deviation from a linear phase.

[Pavs_dBm] source input power: The average source input power.

[our_pae] power added efficiency: The power-added efficiency of the power amplifier.

[our_dcrf] DC to RF power efficiency: The DC-to-RF power efficiency of the power
amplifier.

[Gain] power gain: The gain of the power amplifier.
[Time_Step] time step: The step time of the envelope simulation.
[Freq_Center] center frequency: The center frequency of the input signal.

[S_per_Symbol] samples per symbol: The number of samples per symbol in the
simulation.

[Averager] averager in the adaptation algorithm: The number of observations taken
before a decision is made.

[Alpha_Rate] adaptation rate: The adaptation rate of the algorithm in the 15t loop.
[Beta_Rate] adaptation rate: The adaptation rate of the algorithm in the 2nd loop.

[DataRate] baseband data rate: The baseband modulation rate.
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[ChipRate] chip data rate: The chip rate of the spread spectrum PN sequence.
[SamplerperChip] samples per chip: The number of samples per chip.

[FIRtaps] Finite Impulse Response taps: The number of taps in the FIR filter.
[Freg_IMD] 3rd-order IMD frequency: The 3rd-order intermodulation frequency.

[Fund_Lower] fundamental frequency of lower sideband: The fundamental frequency
of the lower sideband.

[Fund_Upper] fundamental frequency of upper sideband: The fundamental frequency
of the upper sideband.

[Number_Taps] hilbert transform taps: The number of taps in the hilbert transform.

[training] training period: The number of observations required for training.

Encoded Subcircuits

The following section provides useful reference information for the encoded
subcircuits in the Linearization DesignGuide.

Complex_Gain_Adjuster_linlib

Used in the Ptolemy simulations, which operate in Floating Point Domain. This
component is an ideal vector modulator implementation. The input signal is split into
two branches, each branch being individually controlled by inputs | and Q. The
output is the sum of the two branches. The two branches of the vector modulator are
in phase quadrature and the mixer elements are implemented using ideal
multipliers. The vector modulator can achieve phase shifts anywhere in the range
[0,360] as well as amplitudes [0, infinity].

Complex_Gain_Adjuster_RealTime_linlib

Used in the Ptolemy simulations, which operate in Timed Domain. This component is
an ideal vector modulator implementation. The input signal is split into two
branches, each branch being individually controlled by inputs | and Q. The output is
the sum of the two branches. The two branches of the vector modulator are in phase
guadrature and the mixer elements are implemented using ideal multipliers. The
vector modulator can achieve phase shifts anywhere in the range [0,360] as well as
amplitudes [0, infinity].
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ComplexGainAdjuster_linlib

Used in the Analog/RF simulations. This component is an ideal vector modulator
implementation. The input signal is split into two branches, each branch being
individually controlled by inputs | and Q. The output is the sum of the two branches.
The two branches of the vector modulator are in phase quadrature and the mixer
elements are implemented using ideal multipliers. The vector modulator can achieve
phase shifts anywhere in the range [0,360] as well as amplitudes [0, infinity].

HB1ToneFswpSub_linlib

Used in the Analog/RF simulations. This element is a nonfunctional component.

HB1TonePswpSub _linlib

Used in the Analog/RF simulations. This element is a nonfunctional component.

Source_IS95_Revlink_linlib

Used in the Analog/RF simulations. This element is a 1S-95 source generated from
the Library. The dataset used contains baseband | and Q versus time data, which
uses a FIR filter that is longer than the 1S-95 specification. The bit rate is 1.2288
MHz, sampled at 4 bits per symbol.

Source_Pi4DQPSK_linlib

Used in the Analog/RF simulations. This element is a Pi/4 DQPSK source that uses a
root raised cosine filter to generate the | and Q signals. The data rate is 24.3 KHz,
sampled at 10 samples per symbol.

Source_QAM_16_linlib

Used in the Analog/RF simulations. This element is a 16 QAM source that h uses root
raised cosine filter to generate the I and Q signals. The data rate is 24.3 KHz,
sampled at 10 samples per symbol.
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